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  پيشگفتار ناشر
يك درس در يك  هاي دانشگاه پيام نور حسب مورد و با توجه به شرايط مختلف كتاب

و  ،، مـتن آزمايشـگاهي، فرادرسـي   كتـاب درسـي  صـورت   بـه  يا چند رشتة دانشـگاهي، 
  . دنشو درسي چاپ مي كمك

نيازهـاي  ي صاحب اثـر اسـت كـه براسـاس     مهاي عل ثمرة كوشش درسيكتاب 
، طراحـي   هـاي مصـوب تهيـه و پـس از داوري علمـي      درسي دانشـجويان و سرفصـل  

پـس از  . رسـد  به چـاپ مـي   ،آموزشي علمي و هاي در گروه آموزشي، و ويرايش علمي
 هايبـا دريافـت نــظر   ها و داوري علمي مجدد و  نظرخواهيبا چاپ ويرايش اول اثر، 

صـاحب اثـر در كتــاب تجديدنــظر     ،متناسب با پيشرفت علوم و فناوري و اصـلاحي
  . شود چاپ ميجديد  زباني و صوري با اعمال ويرايش كتاب ويرايش جديد كند و مي

 كمـك اسـتفاده از آن و  است كه دانشـجويان بـا    راهنمايي) م( متن آزمايشگاهي
  . دهند آزمايشگاهي را انجام مي و كارهاي عملي ،استاد

 ـ بـه منظـور غنـي   ) ك( درسي كمكو ) ف( هاي فرادرسي كتاب ر كـردن منـابع   ت
دانشـگاه   وبگـاه ند و يـا در  شـو  و بر روي لوح فشرده تكثير مـي درسي دانشگاهي تهيه 

  . گيرند قرارمي
  

  مواد و تجهيزات آموزشي وليدمديريت ت



 



  فهرست

  نه...............................................................................................................پيشگفتار

  يازده..............................................................................................................مقدمه

  1........................................................................................ها كار با داده ـ اولفصل 
  1.........................................................................................................................اهداف
  1..........................................................................................................................مقدمه
  2........................................................................................................... نرم افزارياجرا

  4.................................................................................................................هاورود داده
  7............................................................................................................ها دادهي رهيذخ
  8.......................................................................................................... اطلاعاتيابيباز
  9.............................................................................................................ها دادهشيرايو

  10......................................................................................... چند ستونيهاتلفيق داده

  11....................................................................................... يك ستونيهاتفكيك داده

  14............................................................................................ الگوداريهاساختن داده

  20.........................................................................................................ها دادهيبندرتبه

  23....................................................................................................هامرتب كردن داده

  23....................................................................................... حرفييهامرتب كردن رده

  25...................................................................................................ياضيي رهامحاسبه

 پنج



  29..........................................................................................تبينيقدرت محاسبه در م

  30.....................................................................................................ها انواع دادهليتبد

  32........................................................................................................ها نوع دادهرييتغ

  33..........................................................................................................هاسيكار با ماتر

  35....................................................................................................محاسبات ماتريسي

  41...................................................................................يفيآمار توص ـ دومفصل 

  41.......................................................................................................................اهداف

  41........................................................................................................................مقدمه

  42...........................................................................................................نيجدول فراوا

  59....................................................................................................................نمودارها

  64............................................................................................................ينمودار ستون

  69...........................................................................................................يانمودار دايره

  90..................................................................................... توصيفييها آمارهىمحاسبه

  96................................................. آنهايهايژگي احتمال و ويعهايتوز ـ سومفصل 

  96.......................................................................................................................اهداف

  96........................................................................................................................مقدمه

  97..............................................................................................هاي تصادفي توليد داده

  105................................................................................................... احتماليهاتوزيع

  112.........................................................................هاي احتمال نمايش نموداري توزيع

  117...................................................نانياطمآزمون فرض و فاصله  ـ چهارمفصل 

  117.....................................................................................................................اهداف

  117......................................................................................................................مقدمه

  118.............................................................................ناني اطمىآزمون فرض و فاصله

  123..................................... جامعهكي نيانگي براي مي اطمينان و آزمون فرض فاصله

  136........ي نرمال هاي دو جامعه ي اطمينان و آزمون فرض براي تفاوت ميانگين فاصله

  153.............................................................ي نسبتآزمون فرض و فاصله اطمينان برا

  161......................................................ي اطمينان براي واريانس آزمون فرض و فاصله

 شش



  172.......................................................................رهاي متغنيارتباط ب ـ پنجمفصل 

  172.....................................................................................................................اهداف

  172......................................................................................................................مقدمه

  173......................................................................................تحليل مناسب كدام است؟

  174.......................................................................................ارتباط بين متغيرهاي كمي

  191..........................................................................ارتباط بين متغيرهاي كيفي و كمي

  206......................................................................................يفيهاي ك ارتباط بين متغير

  211........................................................................................................................منابع
  213........................................................................................................................هينما

 
 
 
 
 
 
 
 
 
 

  

 هفت



 



  

  پيشگفتار
هـاي  افـزار  نرم امروزه. افزار معني خاصي نخواهد داشت    شك آمار كاربردي بدون نرم     بي

 پيـشرفت آن    و بـه  هاي متفاوت بـه كمـك آمارشناسـان آمـده           با توانايي آماري  مختلف  
به دليـل سـادگي و در       تب  ميني در بين نرم افزارهاي مورد استفاده،       . اندسرعت بخشيده 

مورد نظر نويـسندگان ايـن      عين حال قابليت بالا به همراه مقبوليت آن در بين آمار دانان             
كتاب حاضر تنها در پي آموزش روش استفاده از نرم افـزار             اما    . قرار گرفته است   بكتا

شـناخت صـحيح روش تحليـل         ايجاد انگيـزه در     جهت   نيست بلكه  تلاش در       تبميني
، بـا رويكـردي جديـد       هـاي بـه كـار رفتـه       ويژه درك آگاهانه از نتايج روش       مسايل و به  

نگارندگان در حد بضاعت خود در پـي آن هـستند كـه بـا تبيـين يـك        .است)  تلفيقي(
 نگـرش خواننـده را      ينحـوه ) اربا استفاده از نرم افز    (چارچوب نظري و نگاهي تحليلي      

اي متمـايز و  در واقـع هـدف بـه كـار بـردن شـيوه       .دن ـنسبت به تحليل مسايل تغيير ده 
ي تلفيقي آموزش   در اين راستا از شيوه    . ي پيشين است  هاي به كار رفته   متفاوت با روش  

لـذا  . ايمود جسته افزار س مفاهيم با استفاده از ابزار رايانه و يا با بيان بهتر با استفاده از نرم              
ي در گرداوري مطالب مقدماتي آمار با رويكرد فوق،  سعي شده تا حـد امكـان از ارايـه     

-توانـد پاسـخ   در اين خصوص منابع ذكر شده مي      اما  . هاي تئوري خودداري شود   فرمول

. هاي تئوري خوانندگان باشندگوي سئوال
  

طـرح   ي بين تا فاصلهكندگر را كمك ميايجاد و به كار گيري روشي كه پژوهش
. فرضيه تا  آزمون آن را بهتر بپيمايد از جمله اهداف نگارندگان اين كتـاب بـوده اسـت                  

لازم است هـدف از تحقيـق       ، ابتدا   مسئلهو تبين يك    به منظور تشريح    لازم به ذكر است     

 نه



 طـرح مـسئله،     پـس از  . گيري طرح مسئله است      شكل يهكه اين خود نقط   شود  مشخص  
آفريند وآنگاه با استفاده از        ذهن خود مي   اي از آن مسئله در      و يا فرضيه    نظريه پژوهشگر،

 كـه   گردد و اين همان مرحلة آزمون است        به جستجوي شواهد و اسناد مي     منابع موجود   
  .بردميپي گر در اينجا به صحت و سقم فرضية خود پژوهش

اميد است  مجموعه مباحث مطرح شده در اين كتاب در حد آمار مقدماتي بوده و              
مطالب بيشتري از آمار پيـشرفته را بـه ايـن           ) چنانچه فرصت مجال دهد   (كه نويسندگان   

پيام نور بـه خـاطر       دانيم از انتشارات دانشگاه   در پايان برخود لازم مي    . مجموعه بيفزايند 
- به خـاطر راهنمـايي      و احسان خدابخشي    سعيد گودرزي  ان آقاي همكاري در چاپ و از    

همچنين از جناب آقـاي دكتـر يارمحمـدي         . ل تشكر را داشته باشيم    كماشان  هاي ارزنده 
در . يمارزگ ـ بـسيار سـپاس    را متقبل شدند   زحمت ويرايش    ،ي فراوان كه با وجود مشغله   

-هاي خويش سپاس   نويسندگان از خانواده   تر،خالصانههمواره و    بلكه    اما نه كمتر   خاتمه

  . اندوري مطالب بودهارند كه همواره پشتيبان و مشوق ايشان در گردازگ
  

  نويسندگان
  1388بهار 

  
  
  

  
  
  
  

 ده



  

  مقدمه
تـرين شـكل و بـا    انـد تـا بـا سـاده    از آنجا كه نويسندگان اين نوشته همواره سعي داشته   

نوع برخورد نويسندگان   بيان  استفاده از ابزارهاي متفاوت مفاهيم را آموزش دهند، شايد          
 اننده را بيشتر در راستاي نوع آموزش       خو ،آمده در حين گردآوري مطالب    با مسايل پيش  

آنچه كه نگارش   . دانيماز اين رو ذكر دو اصل را لازم مي        .  قرار دهد  و اهداف اين نوشته   
رعايـت كـردن    ه بـود    تا حدودي با مشكل مواجه كرد     با اهداف نويسندگان    اين كتاب را    
 در  گاهـاً كـه     كاربردي بودن مفاهيم و پرهيز از بيان مباحـث تئـوري            ابتدا  . دو اصل بود  

شد و در برخي از موارد فـرض شـد كـه خواننـده از               برخي موارد به ناچار بايد بيان مي      
امـا اصـل دوم     . بـه منـابع رجـوع خواهـد كـرد         مطالب تئوري آگاه و يا در صورت نياز         

 بلكه  تب نيست يادآوري اين موضوع بود كه كتاب مذكور، در پي آموزش نرم افزار ميني            
اميد است خواننده همـواره ايـن نـوع نگـرش را در سرتاسـر ايـن                .استفاده از آن است   

 چرا كه يادآوري اين موضوع به فراگيري بهتر مطالب كمـك            دشنوشته در ذهن داشته با    
   .خواهد كرد

 ـفـصل اول    تـب،   اما بر حسب نياز و در حد آشنايي با نرم افزار ميني            ي ه نحـوه  ب
هاي   ها و ويرايش    عات و اجراي پردازش   افزار و همچنين چگونگي ورود اطلا     اجراي نرم 

هـاي مربـوط بـه        لذا خواننده همراه با آمـوزش نـرم افـزار بـا روش            . لازم پرداخته است  
ي مورد اسـتفاده تـا      هاسعي شده است روش   . شودر اين فصل آشنا مي    دها    مديريت داده 

در ابتـداي هـر فـصل نكـاتي كـه خواننـده پـس از                . حد ممكن ساده و قابل فهم باشند      

 يازده



 ـ  ا .ي آن فصل فرا خواهد گرفت عنوان شده است        طالعهم  خواننـده كمـك     هين موضوع ب
  . هاي خويش را با توجه به اهداف ابتداي هر فصل بيازمايدكند كه تواناييمي

ي آمار توصيفي مورد بررسي قـرار گرفتـه         در فصل دوم چگونگي گزارش و ارايه      
 مقـاديري از قبيـل نمـا،        ي ، نمايش ترسيمي، و محاسـبه     ها  دادهبندي    تنظيم و طبقه  . است

هـاي مختلـف      از جمله مباحثي است كه در اين فصل بـا اسـتفاده از داده               ميانگين، ميانه 
شـنايي خواننـده بـا كاربردهـاي        ي مـسايل متفـاوت آ     هـدف از ارايـه    . بحث شده است  

  .هاي مختلف استي مفاهيم آمار توصيفي در زمينه گسترده
 للـذا فـص   . ها يكي از مباحث مهم در آمار اسـت         هاي احتمال و ويژگي آن    توزيع

هـاي   توليـد داده   سـوم در فـصل    . سوم به اين مبحث مهـم اختـصاص داده شـده اسـت            
ي هـاي چگـالي و مقايـسه    و رسـم تـابع  هاي احتمالهاي تابعتصادفي،  محاسبه ويژگي   

همچنـين چگـونگي توليـد اعـداد      . هاي مختلف مورد بررسي قـرار گرفتـه اسـت         توزيع
هـا در ايـن فـصل        براي برخـي از توزيـع      ) سازي بسيار مفيد است   كه در شبيه  (تصادفي  

   . ث شده استبح
و آزمـون فـرض     .  آمار استنباطي در فصل چهارم مورد بررسي قرار گرفته اسـت          

دهنـد بـا تكيـه بـر بررسـي برقـرار بـودن              برآورد كه مبناي آمار استنباطي را تشكيل مي       
در اجـراي   . هاي آماري در اين فصل بررسي شده است       هاي آزمون   مجموعه پيش فرض  

ي هاي هر آزمون مورد بررسي قرار گرفتـه و بـا توجـه بـه نتيجـه     هر آزمون ابتدا فرضيه   
يكي از اهداف ايـن بخـش عـلاوه بـر آمـار             . ستبررسي، آزمون مناسب انتخاب شده ا     

ايـن اصـل در سرتاسـر فـصل        . استنباطي آشنايي كاربران با اين نوع نگرش بـوده اسـت          
شـنايي  رود تا كاربران پس از مطالعه اين فصل عـلاوه بـر آ            انتظار مي . رعايت شده است  

  .  اي داشته باشندويژههاي آن نيز توجه فرض  آمار استنباطي به پيشبا
هـاي مختلـف آن بررسـي         ها و تحليل    اما در فصل آخر ارتباط بين متغيرها، روش       

در فـصل پـنجم      . ها بحث شده است   هاي متفاوت با توجه به نوع داده      روش. شده است 
تعيين تحليل مناسب در حالت دو      ،  متغيرهاي مستقل و وابسته   خواننده با مفاهيمي چون     

 تحليـل جـداول      و همچنـين     ليـل واريـانس    تح ،  تحليل رگرسيون و همبستگي   ،  متغيره
در گر  پژوهشگويي صحيح   هدف كلي اين فصل آمادگي پاسخ     .  آشنا خواهد شد   توافقي

  .بيان ارتباط بين دو متغير و يافتن تحليل مناسب است

 دوازده



  

  اولفصل 

  هاكار با داده

  اهداف 

 :شود در پايان فصل، دانشجو با مفاهيم زير آشنا مي

  تبار مينيافزآشنايي با نرم. 1
  تبها در مينيهاي مختلف و ويرايش آنوارد كردن داده. 2
 تبدخيره كردن و بازيابي اطلاعات در ميني. 3

  تب با استفاده از مينيهاي رياضيانجام محاسبه. 4

  مقدمه

هـا و     ي ورود اطلاعـات و اجـراي پـردازش          افزاري، نحـوه    يكي از موارد مهم در هر نرم      
هاي ورود و ويرايش      خوشبختانه اغلب روش  . هاست  روي اين داده  هاي لازم بر      ويرايش

 ،SPSS ،Statistica ،Stata ،S-Plusافزارهــاي آمــاري ماننــد  هــا در بــسياري از نــرم داده
Minitab   ي دقيق اين مطالب و يـا آشـنايي بـا             يكسان است و از اين جهت مطالعه      ...  و

اي مربوط به نرم افزارهاي ديگر نيز،       ه  افزارها در اجراي روش   روش كار يكي از اين نرم     
  . تواند بسيار مفيد باشد مي



  تب     آمار كاربردي با ميني 2

هـا    هـاي مربـوط بـه مـديريت داده          ي اين فصل به تفصيل به بيـان روش          در ادامه 
البته با توجه به سطح نياز به ايـن مفـاهيم، از بيـان برخـي از دسـتورها كـه                     . پردازيم  مي

  . اند صرف نظر شده است كارايي چنداني نداشته

  اي نرم افزاراجر

گونـه كـه    همـان . شـود  نمايان مي  1-1اي مانند شكل    ، پنجره Minitab فزارابا اجراي نرم  
 ,… ,Data, Edit( هـاي مختلفـي   شود در قسمت بالاي اين شـكل آيكـون  ملاحظه مي

Help (        افـزار را   هاي اين نرم  ي خاصي از كاربرد   وجود دارد كه هر يك از آنها،  مجموعه
.  خواهند شـد   هاي مرتبط توضيح داده   ها در بخش  هر يك از اين آيكون    . دهندنمايش مي 

علاوه بر ايـن    . شود پس از هر اجرا مشاهده مي      1-1لازم به ذكر است كه همواره شكل        
ي    پنجـره . شـود  در اين شكل مشاهده مـي      Worksheet و   Sessionها، دو پنجره      آيكون

Sessionي   در قــسمت بــالاي شــكل و پنجــرهWorksheet در قــسمت پــايين شــكل 
  . شودمشاهده  مي

  

 
  اوليه پس از اجراي نرم افزارى پنجره 1 -1 شكل



 3 ها    كار با داده  

  
اي توانـد هـر نـوع داده      كه مـي  ( به منظور نمايش اطلاعات      Worksheetى پنجره

-توان اطلاعات را وارد و بر روي آنها ويـرايش         مىدر اين پنجره    . شوداستفاده مي ) باشد

 نيـاز داشـته    Worksheetزمان به چنـد     چه كاربر به طور هم     چنان .هاي لازم را انجام داد    
تواند با استفاده دسـتور      اطلاعات متفاوتي موجود باشد، مي     Worksheetباشد كه در هر     

File►New ي   و انتخاب گزينـهMinitab Worksheet      ،بـه هـر تعـداد كـه لازم باشـد 
Worksheet   ـ    .  جديد ايجاد كند  هـر  . كـامپيوتر دارد  ى ه حافظـه  البته تعداد آنها بستگي ب

توان ايجـاد   مى هاي بيشتري    Worksheetچقدر حافظه بيشتري در دسترس باشد، تعداد        
  .كرد

ي مربوط بـه اجـراي برخـي از         ها است كه شامل خروجي    Sessionدوم  ى پنجره
توان از اين پنجره براي اجراي دستورهاي مربوط        مىهمچنين  . فزار است ادستورهاي نرم 

بـراي ايـن منظـور      . اسـتفاده كـرد   ) Dosتحـت   (افـزار   اين نرم تر  قديمي يهابه ويرايش 
محتويـات ايـن پنجـره قابـل        . را اجرا كنيد  دستورها را در اين پنجره نوشته و سپس آن          

  . ذخيره كردWordهاي ديگر مانند توان آنها را به راحتي در محيطمىويرايش هستند و 
 كه همواره قابل مشاهده هستند،     Worksheet و   Sessionي  اما به غير از دو پنجره     

ــره ــام  پنج ــه ن ــومي ب ــره  Project Managerي س ــايين پنج ــه در پ ــود دارد ك ي     وج
Worksheet    توان بـه  ي اين پنجره ميبراي مشاهده. شود به حالت نيمه فعال مشاهده مي

  . سه طريق عمل كرد
   Windows►Project Managerبا استفاده از دستور  -1
  Ctrl+Iفاده از كليدهاي با است -2

براي اين  . شودبا  فعال كردن خود پنجره كه به صورت نيمه فعال مشاهده مي             -3
 . منظور روي آيكون بازكردن پنجره كليك كنيد

ايـن پنجـره    . شـود مى بـاز    2-1ي مانند شـكل     اپس از اجراي يكي از موارد فوق پنجره       
  .در حال اجراستى پروژهى شامل اطلاعاتي درباره
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 اطلاعات برنامهى   پنجره2-1 شكل

  هاورود داده

 Minitabفـزار   ادر نـرم  . هاي متفاوتي دارند    ي، ماهيت گيربا توجه به مقياس اندازه    ها داده
نيست، اين كار به صـورت خودكـار توسـط نـرم          ) هاداده(نيازي به تعريف نوع متغيرها      

ي ي زيـر را بـه عنـوان داده        ه يكي از سه نوع داد     Minitabنرم افزار   . شودافزار انجام مي  
  :گيرد ورودي در نظر مي

  ...مانند قد، وزن و): اندكه از ارقام تشكيل شده(ي عددي ها داده-1
  ....مانند نام افراد، جنس افراد و): انداز حروف تشكيل شده(ي حرفي ها داده-2
  2:59:45 يا 15/8/1383مانند ): باشندكه مربوط به تاريخ مي(ي زماني ها داده-3

اين .  درج شده است…,C1, C2, C3ي ها و در رديف اول، نامWorksheetى در پنجره
هـا را    چـه كـاربر، داده    چنان. فزار هستند اي اين نرم  هاستونى شمارهى نشان دهنده ها نام

ها وارد كند، نرم افزار اطلاعات ايجاد شده در آن سـتون را بـا نـام                 در يكي از اين ستون    
كـه بـه    (تواند نامي دلخواهي به جـز نـام سـتون           اما كاربر مي  . دشناسي ستون مي  شماره

بـراي  . براي ستون اطلاعات ورودي انتخـاب كنـد       ) صورت خودكار تعريف شده است    
تـوان نـام   مى …,C1, C2, C3هـاي  اين منظور در رديف دوم و در زير هـر يـك از نـام   

-ها، تحليل يك از ستون  با تعريف نام جديد براي هر       . دلخواه را براي متغيرها وارد نمود     
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-گذاري ستون براي نام . شوند مي ها نشان داده  هاي بعدي با نام تعريف شده در خروجي       

  :ها بايد به موارد زير دقت داشت
  . گذاري استفاده كندتواند از اعداد، حروف يا تركيبي از آنها براي نامكاربر مي -1
 .  كاراكتر باشد31تواند بيش از طول نام اختصاص داده شده نمي -2

 . هاي متفاوت استفاده كردتوان از اسامي مشابه براي ستوننمي -3

 .$به عنوان مثال : ها باشدتواند شامل نشانهگذاري نمي  نام-4

 .تواند با يك فضاي خالي شروع  و يا تمام شودگذاري نمي  نام-5

البتـه ايـن    . اشـد  سطر داشـته ب    10000000 ستون و      4000تواند تا    مي Worksheetيك  
  . ي مورد استفاده نيز بستگي داردقابليت  به حافظه رايانه

روش سـطري و    : شوند، كه عبارتند از    مىWorksheetبه دو صورت وارد     ها داده
ى  و در گوشـه    3-1توسط يك فلـش كـه در شـكل          ها ورود داده ى نحوه. روش ستوني 

ه ايـن فلـش بـه       در صورتي ك ـ  . شود، مشخص شده است   مىسمت چپ بالاي آن ديده      
 وارد شده باشد بـا زدن كليـد         C1سمت پايين باشد و اولين عدد در اولين رديف ستون           

Enter         مكان نما به رديف دوم از ستون C1    بـه صـورت سـتوني      ها  خواهد رفت و داده
براي ورود مشاهدات به صورت سطري، كافيست روي فلشي كه در بالا            . شوندمىوارد  

  .تا فلش به صورت افقي درآيدگفته شد يك بار كليك كنيد 
   

 
  ها ورود دادهى مربوط به نحوهى   پنجره3-1 شكل
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  هانمايش داده

بـا  ها سـتون . شـوند مىوارد ها و ثابـت ها ، ماتريس هادر قالب ستون  ها  داده Minitabدر  
C1, C2,…باها ، ماتريسM1, M2,… با ها و ثابتK1, K2,… از . شوندمى نمايش داده

براي نمايش دادن هر كـدام از ايـن         . شوندمىدر صفحه ديده    ها ناين سه نوع، تنها ستو    
. شـود مى اسـتفاده  …Data► Display data از دستور Sessionى در پنجرهها نوع داده

مورد ى با انتخاب نوع داده   . شودمى باز   4-1يك پنجره مانند شكل     با اجراي اين دستور     
علاوه بر ايـن    . شوندمى ظاهر   Sessionى ها در صفحه  ، داده OKي  نظر و انتخاب گزينه   

تـوان بـه ترتيـب بـا      مىWorksheet هم با انتخاب هـر  Project Managerى در پنجره
و ها ، ثابـت  ها اطلاعـاتي راجـع بـه سـتون        Matrices و   Columns  ،Constantsانتخاب  
، )Name(اين اطلاعات شـامل نـام       .  كسب كرد  Worksheetي موجود در آن     هاماتريس
و ) Type(، نـوع داده     )Missing(ي گمـشده    ها، تعداد داده  )Count (، تعداد )Id(شماره  
  .آن است) Description(هاي  توضيح
  

 
  هامربوط به نمايش دادهى   پنجره4-1 شكل
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  هاي داده ذخيره

بـا اجـراي     . را ذخيره كنيم  ها ي بعدي از اطلاعات گذشته بهتر است داده       هابراي استفاده 
ي موجـــود در هاتـــوان داده مى…File►Save Current Worksheet asدســـتور 

Worksheet    بـاز   5-1ي ماننـد شـكل      ابا اجراي اين دستور پنجـره     .  فعال را ذخيره كرد 
 بـراي وارد كـردن يـك نـام     File Nameقسمت . اين پنجره چند قسمت دارد  .شودمى

ي  نيز بـراي انتخـاب نـوع ذخيـره    Save as Typeقسمت . دلخواه براي فايل داده است
گيريـد كـه بـا       را در نظر مي    Minitab فرض فايل    افزار به طور پيش     نرم.  است اطلاعات

چه كاربر بخواهد به صورت ديگري اطلاعات را ذخيـره          چنان.  همراه است  mtwپسوند  
 Excelى به عنوان مثال با انتخاب گزينه. هاي ديگري را انتخاب كندتواند گزينهكند، مي

 همـراه اسـت،   Xls  كـه بـا پـسوند    Excelصورت فايل  ها را به    توان داده ، مي 97-2002
بعـد  . توان آدرس محل ذخيره را مشخص كردمى نيز Save inدر قسمت  . ذخيره نمود

، فايل مورد نظـر بـا توجـه بـه       Saveي  ، با انتخاب گزينه   هاگزينهى از تكميل كردن همه   
  .شودي فايل در مكان مورد نظر ذخيره مينوع ذخيره

سـت بايـد    ها، نمودارها و داده   ها تمام پروژه كه شامل خروجي     براي ذخيره كردن  
اجرا مانند حالت قبل است و ى نتيجه.  را اجرا نمود…File►Save Project Asدستور 

اما براي ذخيره كـردن تمـام پـروژه دو          . انتخاب شوند ها به همان صورت هم بايد گزينه     
ي هاراسـت پنجـره بـا نـام       در گوشه سـمت     ) هاي قبلي علاوه بر گزينه  (اضافي  ى گزينه

Options   و Security  ى با انتخاب گزينه  .  وجود داردOptionsيي هاتوان تنها قسمت   مى
شـامل پنجـره    ها ايـن قـسمت   . از پروژه را كه مورد نظر اسـت، ذخيـره انتخـاب نمـود             

Session ،Graph ،Project Manager و Dialog Settingاست  .  
ين اطلاعاتي است كه در هنگـام كـار بـا     مربوط به آخرDialog Settingى گزينه

  . ستاي مربوطه شده هامنوها وارد قسمت
اي باشـد و كـاربر مايـل        چنانچه فايل خروجي شامل اطلاعات مهم و يا محرمانه        

 Securityي  توانـد از گزينـه    باشد كه تنها وي به آن اطلاعات دسترسي داشته باشد، مـي           
توانـد بـراي فراخـواني فايـل و يـا           مى كاربر   Securityى با انتخاب گزينه  .  استفاده كند 




